
User Manual 

 
 
 

Fohhn Audio Soft 
 

One software to control everything. 

 

Please read this user manual through carefully before putting 
the system into operation and keep it for future reference. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



2 
 

Contents 
1. Welcome ............................................................................................................................................................. 5 

2. Introduction ........................................................................................................................................................ 5 

2.1 What is Fohhn Audio Soft? ........................................................................................................................... 5 

2.2 What is the Fohhn Audio DSP? ..................................................................................................................... 6 

2.3 What is Fohhn-Net? ...................................................................................................................................... 6 

2.4 System Requirements ................................................................................................................................... 7 

2.5 Download und Installation ............................................................................................................................ 7 

3. The Software User Interface ............................................................................................................................... 8 

3.1 The Menu Bar ............................................................................................................................................... 8 

3.1.1 File ......................................................................................................................................................... 8 

3.1.2 View ....................................................................................................................................................... 8 

3.1.3 Devices .................................................................................................................................................. 9 

3.1.4 User-defined Controls ........................................................................................................................... 9 

3.1.5 Window ............................................................................................................................................... 10 

3.1.6 Setup ................................................................................................................................................... 10 

3.1.7 Help ..................................................................................................................................................... 10 

3.2 Status Bar .................................................................................................................................................... 11 

3.3 Views ........................................................................................................................................................... 11 

3.3.1 Device List ............................................................................................................................................ 11 

3.3.2 Devices ................................................................................................................................................ 12 

3.3.3 Input and output channels .................................................................................................................. 12 

3.3.4 Speakers .............................................................................................................................................. 14 

3.3.5 User-defined Controls ......................................................................................................................... 14 

3.3.6 Beam Steering ..................................................................................................................................... 15 

3.4 Context Menus ........................................................................................................................................... 16 

3.4.1 Device List ............................................................................................................................................ 16 

3.4.2 Devices ................................................................................................................................................ 16 

3.4.3 Channels .............................................................................................................................................. 17 

3.4.4 Speakers .............................................................................................................................................. 18 

3.4.5 User-defined Controls ......................................................................................................................... 19 

3.4.6 Beam Steering ..................................................................................................................................... 19 

4. Operation .......................................................................................................................................................... 20 

4.1 Fohhn-Net Setup ......................................................................................................................................... 20 

4.1.1 Starting the Software .......................................................................................................................... 20 

4.1.2 Configuration Using Multiple Nodes ................................................................................................... 21 

4.1.3 ID Allocation ........................................................................................................................................ 23 



3 
 

4.2 Presets ........................................................................................................................................................ 24 

4.3 System Setup .............................................................................................................................................. 25 

4.4 Settings for Devices, Channels and Speakers ............................................................................................. 25 

4.4.1 Renaming Devices ............................................................................................................................... 25 

4.4.2 Rename Channels ................................................................................................................................ 25 

4.4.3 Arranging the Loudspeakers and Devices ........................................................................................... 26 

4.4.4 Combine Speakers (Focus Modular and Focus Venue only)................................................................ 26 

4.5 DSP Functions ............................................................................................................................................. 27 

4.5.1 Volume ................................................................................................................................................ 27 

4.5.2 Routing ................................................................................................................................................ 27 

4.5.3 Delay .................................................................................................................................................... 28 

4.5.4 X-Over .................................................................................................................................................. 28 

4.5.5 Equalizer .............................................................................................................................................. 28 

4.5.6 Graph ................................................................................................................................................... 29 

4.5.7 Dynamics ............................................................................................................................................. 29 

4.6 Status .......................................................................................................................................................... 30 

4.7 Beam Steering and Focus Simulation ......................................................................................................... 31 

4.7.1 Definition ............................................................................................................................................. 31 

4.7.2 Focus Simulation Parameters .............................................................................................................. 32 

4.7.3 System Setup (Focus-Series) ................................................................................................................ 32 

5. Advanced Operation ......................................................................................................................................... 34 

5.1 Creating Groups .......................................................................................................................................... 34 

5.2 Routing ........................................................................................................................................................ 35 

5.3 User-defined Controls ................................................................................................................................. 36 

5.4 Sub Arrays ................................................................................................................................................... 40 

5.4.1 Guidelines ............................................................................................................................................ 40 

5.4.2 Subwoofers as a Combined Speaker ................................................................................................... 40 

5.5 Preset Management ................................................................................................................................... 42 

5.5.1 Exporting Presets ................................................................................................................................. 42 

5.5.2 Import Presets ..................................................................................................................................... 42 

5.6 Projects ....................................................................................................................................................... 43 

5.6.1 Save Project as ..................................................................................................................................... 43 

5.6.2 Load Project ......................................................................................................................................... 43 

5.7 Identifying a Fohhn-Net Device .................................................................................................................. 44 

5.8 Signal Generator ......................................................................................................................................... 44 

5.9 Changing a Fohhn-Net ID ............................................................................................................................ 45 

 



4 
 

6. Appendix ........................................................................................................................................................... 46 

6.1 Updating Your Firmware ............................................................................................................................. 46 

6.2 Amplifier Setup ........................................................................................................................................... 47 

6.3 Shortcuts/Hot Keys ..................................................................................................................................... 48 

6.3.1 General Shortcuts ................................................................................................................................ 48 

6.3.2 Shortcuts for the Input-/Output Channels view context menu ........................................................... 49 

6.3.3 Shortcuts in the Routing dialog ........................................................................................................... 49 

6.4 Troubleshooting .......................................................................................................................................... 50 

6.5 Remote Configuration ................................................................................................................................ 51 

6.6 Password Lock............................................................................................................................................. 52 

6.6.1 Setting a Password Lock ...................................................................................................................... 52 

6.6.2 Cancelling Password Lock .................................................................................................................... 53 

6.6.3 Password Reset (if password is forgotten) .......................................................................................... 53 

6.7 Disclaimer and Copyright ............................................................................................................................ 53 

6.7.1 Disclaimer ............................................................................................................................................ 53 

6.7.2 Copyright ............................................................................................................................................. 53 

6.8 Trademarks ................................................................................................................................................. 54 

6.9 Contact Address .......................................................................................................................................... 54 

 

  



5 
 

1. Welcome 
Congratulations on purchasing Fohhn products and thank you for trusting in our systems.  

Fohhn Audio Soft acts as a control centre for all the DSPs that are built into our active devices. These DSPs include 

all the necessary functions for carrying out high-quality, professional audio processing.  

To maximize the potential of your Fohhn products and to guarantee trouble-free operation, we recommend 

reading the following manual carefully before using your system. We also suggest keeping this information to 

hand for the benefit of future users. 

Please take time to read the following instructions carefully and thoroughly, even if you are already an 

experienced user. 

2. Introduction 

2.1 What is Fohhn Audio Soft? 
Fohhn Audio Soft is a software application for Windows-based PC that forms the control centre of your Fohhn 

System. Its user interface gives software access to the DSPs (digital signal processors) that are built into all active 

Fohhn devices, enabling the remote control of all parameters and functions needed for professional, high-quality 

audio processing. 

 

 

At the same time, Fohhn Audio Soft also enables the management and control of up to 254 active Fohhn devices, 

giving you constant feedback on both the status of the connected devices and their respective parameter values. 
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2.2 What is the Fohhn Audio DSP? 
As a user, the Fohhn Audio DSP gives you instant access to all the functions needed for fast, efficient and of 

course excellent-sounding audio processing. 

The Fohhn Audio DSP consists of two separate digital signal processors that are built into all of Fohhn’s active 

hardware devices (loudspeakers, amplifiers and controllers): The first Audio DSP is used for calculating high-

quality signal processing functions. This enables you – with help from Fohhn Audio Soft – to delve into the various 

parameters and actively shape the sound characteristics of the Fohhn loudspeaker systems. The second DSP 

takes care of the loudspeaker management.  

Any Fohhn loudspeaker systems equipped with Fohhn Beam Steering Technology can be controlled using Fohhn 

Audio Soft. 

A database for all Fohhn loudspeakers is also available via the Fohhn Audio DSP. This enables all current 

loudspeaker systems to be registered in Fohhn Audio Soft, so that a loudspeaker setup can be configured with 

minimum effort.  

 

2.3 What is Fohhn-Net? 
Fohhn Audio Soft reaches all Fohhn devices via the Fohhn-Net. An access point to the Fohhn-Net is called a 

Node in Fohhn Audio Soft. 

This can be an external USB or Ethernet adapter, behind which several Fohhn Net devices are then located, or 

the Node is a USB or Ethernet interface integrated into the device. Fohhn Audio Soft can communicate via all 

Nodes simultaneously. 

 

 

 

 

 

 

 

 

 

 

 

 

Fohhn devices have a Fohhn Net ID. Each ID in the Fohhn Net may only occur once. 
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2.4 System Requirements 
To use Fohhn Audio Soft, you need a commercially available PC with the following spec: 

• Computer and processor: x64 multi-core processor 

• Random access memory (RAM): 4 gigabytes (GB) of RAM 

• Hard disk: 40 megabytes (MB) of free space 

• Display: Resolution of at least 1366 x 768 

• Operating system: Microsoft Windows 10 or Windows 11 

• .NET version: Microsoft .NET Desktop Runtime 6.0 

• Additional Requirements: Current update status of the operating system 

• A free USB port 

 

2.5 Download und Installation 
The current version of Fohhn Audio Soft can be downloaded for free from www.fohhn.com  

When a software update is available, carry out the following steps in order to install the new version of Fohhn 

Audio Soft on your computer: 

1. Download the new version of Fohhn Audio Soft to your computer. 
 

2. Find the file Fohhn_Audio_Soft_x.x.x_Setup.exe on your computer (x.x.x will denote the actual version 
number). 
 

3. Run the installer program by double-clicking on the file: Follow the on-screen instructions. 
 

4. Click on Install to install the program on your computer. Also confirm this in the User Account Control 
dialog.  
 

5. To complete the installation click on the “Finish” button. 
 

Once installed, the software will be ready to use and can either be opened using the program symbol on the 

desktop, or via the path Start > All programs > Fohhn Audio AG > Fohhn Audio Soft. 
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3. The Software User Interface 
The Fohhn Audio Soft user interface is divided into different areas. These provide access to the various functions 

associated with your hardware, allowing you to control these functions or to view their status, so that you have 

a complete overview of all hardware components at all times. For this purpose, Fohhn Audio Soft includes a 

range of menus and toolbars, as well as interactive GUI (graphical user interface) elements. These will all be 

described in detail on the following pages. 

Fohhn Audio Soft includes the following: 

1. Menu bar 

2. Status bar 

3. Views 

4. Controls within the views 

5. Context menus within the views 

 

3.1 The Menu Bar 
Using the menu bar items, you can directly select a particular function, or open a function view in order to access 

specific actions and context menus. 

 

3.1.1 File 

Here you can select from the following menu items: 

• Load Project 

This lets you load an existing project. 

• Save Project As 

This lets you save the currently loaded project to a preferred location. Saved projects can be loaded 

from here at a later date, or exchanged with other users. A project contains the suffix .fap. 

• Export Preset To File 

This lets you export a self-created Preset and save it to a preferred location: The preset will be filed with 

the suffix .prst. It can then be re-imported or exchanged with other users. 

• Import Preset From File  

This lets you load a Preset to your device.  

• Exit 

Use this command to end your Fohhn Audio Soft session. The last settings you made will remain active 

in the hardware, even after you have quit the software program, until you next change them using 

Fohhn Audio Soft. 

 

3.1.2 View 

Here you can select from the following menu items: 

• Device List  

This lets you open the Device List view, in which all the devices registered in Fohhn Audio Soft are 

displayed. 
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• Devices  

This lets you open the Devices view. Here you have direct access to the spatial arrangement and DSP 

functions of the registered devices.  

• Input Channels  

This lets you open the Input Channels view. Here you can directly access and manage the DSP functions 

in the individual channels of each registered device. An input channel will only be displayed here if the 

device has DSP functions on its input channels. 

• Output Channels  

This lets you open the Output Channels view. Here you can directly access and manage the DSP functions 

in the individual channels of each registered device. 

• Speakers  

This lets you open the Speakers view, where you can enter specific commands relating to any connected 

Fohhn loudspeakers. Here you have direct access to all the DSP functionality in the respective 

loudspeakers, controllers and power amplifiers. 

• User-defined Controls  

This lets you open the User-defined Controls view. Here you can create controls for specific functions in 

grouped devices.  

• Beam Steering  

This lets you open the Beam Steering parameter pages and display. These pages are only available if you 

have Fohhn hardware with Beam Steering capability.   

Zoom  

Using the zoom levels in the associated submenu lets you make the current display smaller (50%, 75%), 

larger (200%) or return it to the standard size (100%). 

 

3.1.3 Devices 

Here you can select from the following menu items: 

• Add Offline Devices  

This lets you add new devices (controllers, power amplifiers, loudspeakers) to your system. These 

devices do not have to be physically connected: They can be virtually added in Offline Mode enabling 

you to create projects in advance without the hardware. 

• Search Device  / Network Scan  

By selecting Search in the Search Device / Network Scan dialog, you can search via Fohhn-Net for existing 

system components, as well as those you wish to add into your system. All recognised devices will be 

displayed in the overview and newly recognised devices can be added into the system. Using the default 

setting, IDs in the range 1-32 will be scanned, but you can alter this setting as required.  

 

3.1.4 User-defined Controls 

Here you can select from the following menu items: 

• Add Volume Group  

In the Add Volume Group dialog, you can combine individual channels from various devices to form a 

group, which can then be controlled using the same volume fader. 

• Add User-defined Controls Window  

If you have generated a common volume control, or common mute buttons for a group, you can use 

this option to create a window for these common controls. 
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3.1.5 Window 

Here you can select from the following menu items: 

• Cascade  

This lets you cascade all the individually opened Fohhn Audio Soft windows in the GUI work area. If you 

open another window, this will be displayed in front of the other windows that are already open. 

• Tile Horizontally  

This lets you combine all individually opened Fohhn Audio Soft windows so that they are displayed on 

top of each other in the GUI work area. If you open another window, this will be added to the horizontal 

arrangement.  

Tile Vertically  

This lets you combine all individually opened Fohhn Audio Soft windows so that they are displayed next 

to each other in the GUI work area. If you open another window, this will be added to the vertical 

arrangement.  

• Arrange Icons  

This lets you arrange any minimized windows at the bottom left of the screen just above the Status Bar.  

• Disconnect  

This lets you release the active window from the main screen, in order to move it to a second monitor 

for example.  

• Device List/Devices/Channels/Speakers/User-defined Controls/Focus Simulation   

These individual windows correspond with the items in the View menu. They can also be opened using 

the buttons on the Toolbar. 

 

3.1.6 Setup 

Here you can select from the following menu items: 

• Language 

The Language dialog lets you switch the user interface between the following languages: English, 

German, French, Norwegian, Finnish, Polish, and Chinese. You can also open the Language dialog 

directly from the right hand side of the Toolbar. 

• Fohhn-Net  

The Fohhn-Net dialog shows all the currently available Fohhn-Net Adapters in the system. You can save 

the current setup as a configuration, or load a previous configuration.  

 

3.1.7 Help 

Here you can select from the following menu items: 

• Update Firmware-  and Speaker Database  

In the Update Firmware and Speaker Database dialog, Fohhn Audio Soft automatically searches the 

Fohhn server for the latest firmware versions for all Fohhn devices and updates the Speaker database. 

This process requires an internet connection. Please note that the files are only downloaded onto your 

computer and are not transmitted to the connected Fohhn devices – that is a separate process. Once 

the update is finished, Close this dialog.  

• About Fohhn Audio Soft  

This lets you open a dialog containing information on the currently installed version of Fohhn Audio Soft 

as well as on the Speaker database. Close this dialog by clicking OK.  
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3.2 Status Bar 
The main purpose of this bar is to display the current status of the different hardware devices, as well as that of 

Fohhn-Net network. What's more, using the various views you can actively engage with the system configuration. 

• Online/Offline  

This display shows the online status of all Fohhn-Net registered devices: In Online mode (green display) 

communication is possible, in Offline mode (red display), it is not. Clicking the display lets you switch 

between Online and Offline modes as required.  

Fohhn-Net  

This display shows the status of the Fohhn-Net nodes. If the display is highlighted in green, both the 

nodes and Fohhn-Net are working correctly. If the display is highlighted in red, there is a problem with 

the nodes that you will need to fix in order for the system to work properly. Click on the display to check 

the error message in the Fohhn-Net Configuration dialog. 

• Search Device / Network Scan 

Click on this display to open the Search Device / Network Scan dialog and scan IDs 1 to 32 (default). You 

can also change the ID filed as required.  

• X/X Devices Online  

This display shows how many devices are included in the setup and how many of these are currently 

online. Click on the display to open the Device List dialog. 

• X/X Devices OK  

This display shows whether all the devices are functioning properly, or whether there are any problems. 

You can see at a glance if any of the Fohhn-Net devices are not working properly and if so, how many.  

 

3.3 Views 
The Toolbar gives you instant access to the various Fohhn Audio Soft views. According to your personal 

preferences, you can use one or more of these views as a workspace.  

 

3.3.1 Device List 

The Device List view provides an instant visual overview of all the devices in your Fohhn-Net setup. As well as 

having an overall view of the active devices, you can also see immediately whether they are all working properly 

and in the event of a malfunction, identify the faulty device.  

 

Here you can see all the recognised and registered Fohhn controllers, power amplifiers and active loudspeakers 

that are in the system, together with the following information, which is shown in tabular form: 

• Device:  The Fohhn product name is shown here. 

• Name:  The device name created by the user is shown here. If no separate name is added,        

the entries under Device and Name will appear identical.  

• ID:  This shows the ID number of the Fohhn Hardware in the Fohhn-Net setup. 

• Version:  This shows the Fohhn hardware’s firmware version.  

• Network: This shows the Fohhn hardware’s network status (Online or Offline). 
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• Status:   This shows whether the hardware is displaying an error message (Protect switch  

active, or temperature warning) or is working normally (Status OK). 

• Data ready: This shows whether all the devices’ DSP data is correctly read back in Fohhn Audio 

  Soft. 

• Node:   This shows the Node / Fohhn-Net adapter to which the hardware is currently  

connected.  

Using the context menus in this view you can, for example, load/save presets for a selected device, change the 

device ID, and rename the device and more.  

 

3.3.2 Devices 

Here, all the recognised and registered hardware devices in the system are displayed as graphic elements. The 

title bar of each window shows the name of each device, plus its ID number. Using the respective context menus, 

you can rename both the devices and their channels. The main window of a device acts simultaneously as its 

control centre, giving you access to all the DSP functions. Just click on one of the buttons at the right hand side 

of each device window. This will open another window where you can access the required functions.  

A green highlight on a button simultaneously acts as an indicator to show that the relevant DSP function is active.  

 

Selecting Devices 

To select a device, simply click on it. At this point, the device name will be displayed in bold black typeface. 

 

3.3.3 Input and output channels 

The left area of this view contains the status information for all channels belonging to the Fohhn controllers, 

power amplifiers and active loudspeakers in your system. Each line corresponds to an individual channel. The 

controls on the right can be used to adjust the individual DSP functions (EQ, Dynamics etc.) for each of these 

channels. 
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The following information is displayed: 

• Speaker: Here you can see the name of the speaker that is assigned to a respective channel of  

a controller or power amplifier using a speaker preset. 

• Channel Name: The name of the respective channel is shown here. In the default settings, channels  

are named as Channel 1 to x. But you can rename them as required. 

• Channel: The number of respective channels is shown here. 

• ID:   Fohhn-Net ID numbers for the hardware are shown here. 

• Device:  Fohhn product names are shown here. 

• Name:  User assigned names are shown here. If no separate user name exists, the entries  

in Device and Name will be identical. 

• Status:  The Fohhn-Net status of the respective channels is shown here. 

• DSP Functions: The ON/OFF status of the DSP functions EQ, Dynamic, X-Over and Delay  

is shown here. 

• Volume:  The ON/OFF status of the channel is shown here, as well as the channel fader’s  

current level value. 

• Signal:  Output levels from -50 dB (green) to +12 dB (red/Clip) are displayed here 

in the following steps: -50, -30, -20, -10, -3, 0, +6, +12.  

• Group:  If the channel is assigned to a Group, the name of that Group will be shown here.  

Using the context menus is this Status view, you can load/save amplifier and loudspeaker presets, rename 

channels, change volume levels/mute/polarity, create/edit Groups and much more. 

The controls to the right of this Input-/Output channels view enable you to adjust the channel-related DSP 

functions. If you want to simultaneously adjust the volume levels on several channels, this is done relative to the 

existing levels on those individual channels – in this case the relevant volume controls are marked with an R. 

With other tools (EQ, Dynamics etc.) the newly inserted values are adopted on all channels. 
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3.3.4 Speakers 

The left side of this view displays all the Fohhn loudspeakers in your system as separately positioned units. Each 

unit can be moved around on the work surface to correspond with the physical loudspeaker arrangement. 

 

Selecting a Speaker 

In order to adjust a loudspeaker parameter, you must first select the speaker. Simply click on the relevant 

loudspeaker. The speaker symbol will turn a dark grey.  

You can select and adjust several loudspeakers at once. Click in the Speakers view and drag the cursor (with the 

left mouse button held down) over the relevant speakers. 

 

Please note that, with devices belonging to the Xperience-Series, passively connected subwoofers will not show 

up in the Speakers view – only the two output channels of the relevant device(s). In most cases it is probably 

easier to control these particular devices using the Devices view.  

 

3.3.5 User-defined Controls 

The User-defined Controls view lets you combine devices and/or channels into Groups. Here, you can construct 

Mute-, Preset- and Volume groups.  
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3.3.6 Beam Steering  

This view can only be used with hardware that has Beam Steering capability. It then offers access to all the Beam 

Steering parameters on these loudspeakers. A more detailed description of the respective parameters and their 

operation can be found in the relevant product user manual.  

 

Selecting a Beam Steering speaker 

To adjust the dispersion characteristics of a Beam Steering loudspeaker (i.e. loudspeakers belonging to the Linea 

Focus und Focus Modular series) click in the device selection on the relevant loudspeaker. The selected speaker 

will then be highlighted in blue. 
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3.4 Context Menus 
Many Fohhn Audio Soft functions are exclusively performed using context menus. We will now briefly introduce 

the context menus for each view and explain which functions are performed here. 

 

3.4.1 Device List 

The following commands/functions are available in this context menu: 

• Reassign Offline Devices 

This command enables Fohhn Audio Soft to search for a device that, during the course of operation, 

you may have connected to another Node. The software reassigns the located device to the new Node. 

The command stays active in the background until the device is located. During the search, the Node 

column will show that the relevant device is functioning according to its last settings. After the device 

has been found however, the Node column will display the name of the new Node. 

• Reload Data From Devices  

Here, Fohhn Audio Soft re-reads the current DSP parameters in the selected device and displays them 

in the Devices, Input-/Output Channels and Speakers views. 

• Load/Save Presets  

This lets you load existing presets for the selected device from the Fohhn Pool, or save the current 

configuration as your own preset. 

• Window Positions 

Using the command Show in Devices View, you can make all selected devices in the Devices view visible 

once again, if they have previously been hidden.  

When using the commands Reset Window Position of Device and Reset Speaker Positions, the software 

arranges device and loudspeaker symbols in the Devices and Speaker views, so that all devices and 

loudspeakers currently in use are visible. 

• Remove Selected Device 

This removes the selected device from Fohhn-Net and thereby from the system. Please note that the 

device will be removed without requiring any further confirmation, so if removed by mistake, it will 

need to be newly registered. 

• Settings 

This will open the Settings dialog, provided that additional configuration possibilities are available for 

the device. 

Please note that this function is only available for certain devices. More details can be found in the 

user manual for the relevant device! 

• Manage Speaker Presets 

This opens the Speaker Database. 

• Change Fohhn-Net ID  

This opens the dialog with the same name, in which you can allocate a new network ID to a device.  

• Rename Device 

This opens the Rename dialog, in which you can assign a user-specific name to the device. The device 

will now appear in all the views with this name.  

 

3.4.2 Devices 

The following commands/functions are available in this context menu: 

• Copy  

This lets you copy the value or function status of a desired DSP function (fader, controller or function 

button) to the cache memory.  
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• Insert  

This lets you transfer the copied and temporarily saved value / function status information to the same 

function on another channel. 

• Reset  

This command returns all parameters on the selected device to their default settings.  

• Reset Window Positions  

Using Reset Window Positions, the software arranges the device symbols so that the current device is 

visible.  

• Rename Channels  

This opens the Rename dialog, in which you can allocate a user-specific name to the channels in a device. 

The channels will now appear in all the views with this name. 

• Rename Device  

This opens the Rename dialog, in which you can allocate a user-specific name to the device. The device 

will now appear in all the views with this name.  

 

3.4.3 Channels 

The following commands/functions are available in the Status view on the left side of this context menu: 

• Identify  

This makes the blue LED, or the display on the selected device flash so that it can be visually identified. 

This command can also be carried out using the hot key shortcut “S”. 

• Illumination  

This lets you switch the blue Fohhn logo light on the front of the speaker ON or OFF. These commands 

can also be carried out using the hot key shortcuts “X” and “Y”. 

• Load/Save Preset  

This lets you load presets for the selected device, or save the current configuration as your own preset.  

• Select Speaker Preset From List/Database  

This lets you load a speaker preset for the selected channel: Select from List only refers to the speaker 

presets that are stored in the device, whereas Select from Database refers to all available speaker 

presets.  

• Rename  

This opens the Rename dialog, in which you can allocate a user-specific name to a channel. The channel 

will now appear in all the views with this name. This function can also be carried out using the hot key 

shortcut “A”. 

• Set Gain (Absolute)  

This opens the Gain dialog in which you can enter an absolute gain value for the channel (to one decimal 

place). You can also open this dialog using the hot key shortcut “T”. Entering a value of 0.0 dB returns 

the channel to its default setting. 

• Set Mute  

Using the commands in the relevant submenu, you can switch a channel on, off, or toggle between the 

two. These functions can also be carried out via the hot key shortcuts “Q”, “W” and “E”.  

• Polarity  

Using the commands in the relevant submenu, you can switch the channel’s signal phase to normal, 

inverted, or toggle between the two.  

• Routing  

This opens the Routing dialog. You can also open this dialog using the hot key shortcut “R”. You can find 

more information on this in Chapter 5.2. 
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• Generator  

This opens the Generator dialog, in which you can assign a channel for the output of a test signal (signal 

type, level and frequency are variable).  

• Standby  

This opens the Standby dialog, in which you can switch the current device on or off. You can also carry 

out this function using the hot key shortcut “Z”.  

• Add To Group  

This lets you either create a new group (consisting of several channels), using the New Group dialog, or 

add the selected channel to an existing group. This latter function can be carried out using the hot key 

shortcut “C”. Hot key shortcut “V” can be used to create a new group. 

• Remove From Group  

This lets you remove the selected channel from the group to which it currently belongs.   

• Rename Group / Change Colour  

This opens the Rename Group / Change Colour dialog, in which you can give the selected group a new 

name, or assign a new colour to it. You can also carry out this function using the hot key shortcut “B”. 

• Activate Single/Group Select Mode 

This lets you temporarily remove a channel from a group (Single Select Mode) or reinstate a channel 

back into a group (Group Select Mode). You can also carry out this function using the hot key shortcuts 

“F” and “G”.  

• Manage Speaker Presets  

This lets you load new speaker presets from the Fohhn Database into the device. This is relevant when 

a new speaker model becomes available. 

 

3.4.4 Speakers 

The following commands/functions are available in this context menu: 

• Sign  

This makes the blue LED, or the display on the selected device flash so that it can be visually identified. 

• Light ON/OFF  

This lets you switch the blue Fohhn logo light on the front of the speaker ON or OFF. 

• Load/Save Preset  

This lets you load existing presets for the selected device from the Fohhn Pool, or save the current 

configuration as your own preset. 

• Select Speaker Preset From List/Database  

This lets you load a speaker preset for the selected channel: Select from List only refers to the speaker 

presets that are stored in the device, whereas Select from Database refers to all available speaker 

presets. This function will be relevant if you are using a passive Fohhn loudspeaker on the channel. 

• Rename Channel  

This opens the Rename dialog, in which you can allocate a user-specific name to a channel. The channel 

will now appear in all the views with this name. 

• Combine Speaker Stack  

If you have simultaneously selected several Focus-Series loudspeakers or subwoofers in the Speakers 

view, this will let you combine (i.e. stack) them into a single unit and subsequently handle those 

combined speakers as a single unit. 

• Release Speaker Stack  

This lets you separate the loudspeakers that were previously stacked together. As a result, they can 

once again be individually set up and parameterized. 

 

 



19 
 

 

• Create Group  

If you have simultaneously selected several speakers in the view, this command will let you create a 

new group comprising these speakers. This will allow you to change parameters on all of them at the 

same time. When changing relative volume levels, the relevant faders will show up in blue. 

• Release Group  

This lets you disband an existing group.  

• Manage Speaker Presets  

This lets you load new speaker presets from the Fohhn Database into the device. This is relevant when 

a new speaker model becomes available. 

• Routing  

This opens the Routing dialog. You can find more information on this in Chapter 5.2 “Routing“. 

 

3.4.5 User-defined Controls 

If you have created a volume group using the User-defined Control menu, the following commands/functions 

will be available via this context menu: 

• Delete Window  

This command lets you delete the relevant volume group.  

• Configure  

This command opens the Configure Volume Group dialog, in which you can add additional channels or 

remove existing ones from the relevant volume group configuration.  

If you have added a window for your own controls, via the User-defined Controls menu, the following 

commands/functions will be available via the context menu:  

• Add Mute   

This lets you create a Mute button with which you can mute or activate selected system inputs and 

outputs by clicking on the button.   

• Add Preset  

This lets you create a button with which you can load presets by clicking on the button. 

• Configure  

This opens the Rename dialog, in which you can rename an added control element. 

• Delete Window  

This lets you delete the relevant control element from both the view and the system. 

 

3.4.6 Beam Steering 

The following commands/functions are available in the parameter field of this context menu: 

• Copy  

This lets you copy the value or function status of a desired Beam Steering function to the cache memory. 

• Insert  

This lets you transfer the copied and temporarily saved value / function status information to the same 

function on another channel. 
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4. Operation 
This chapter covers the initial operation of your Fohhn system using Fohhn Audio Soft. The following instructions 

assume that your Fohhn-Net is fully connected: You will find information on connecting data- and audio cables 

in the documentation that was supplied with your Fohhn hardware product. Now start up Fohhn Audio Soft. 

Please check the following carefully: 

• Make sure that your computer is connected to one (or more) Fohhn-Net Adapter(s), via either a USB- 

or Ethernet interface.  

• Make sure that the Fohhn-Net Adapter(s) is/are connected to active Fohhn hardware. 

• Make sure that the Fohhn hardware has the appropriate audio cabling. 

• Make sure that the volume level of the audio source is turned down completely. 

• Make sure that the Fohhn hardware is switched on. 

 

4.1 Fohhn-Net Setup 

4.1.1 Starting the Software 

Find the link to Fohhn Audio Soft on your computer. You can start up the software in the following ways: 

• Double-click on the Fohhn Audio Soft icon, which will have appeared on your computer’s desktop 

following installation. 

• Start the software via the path Start > All Programs > Fohhn Audio AG > Fohhn Audio Soft. 

 

Fohhn Audio Soft will have now started: If one or more Fohhn-Net Adapters have been correctly connected in 

the system, the software will automatically recognise these and incorporate them into the workspace.  

 

The software will then open the Search Device / Network Scan dialog and automatically search the Fohhn-Net 

setup for Fohhn hardware. All recognised devices will now show up in the dialog with the following information: 
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• ID  

This refers to the Fohhn-Net ID that the device has been allocated. You can change this ID as required. 

• Device  

The name of the Fohhn product will appear here. This product name cannot be changed. 

• Version  

This shows the Firmware version for each device.  

• Node  

This shows the name of the Fohhn-Net Adapter to which the components are connected. Several 

Fohhn-Net Adapters can be simultaneously registered in the Fohhn-Net setup. 

As a default, Fohhn Audio Soft searches for devices with ID numbers 1-32. Using the dialog fields From Fohhn-

Net ID and To Fohhn-Net ID, deviant values of between 1 and 254 can be entered, provided you already know 

that the Fohhn devices in question are set to these numbers by default.  Provided that you enter these deviant 

numbers, Fohhn Audio Soft will save them for future registrations. Click on Search to perform a new network 

scan. 

At the end of the search, all recognised Fohhn components will appear in the Find devices dialog, but will not 

have automatically been loaded into the software workspace. This is done as follows: 

• To register all recognised devices, select them in the Add All Devices dialog field, then confirm by clicking 

OK. 

• If you only want to include selected components, click on these in the list while holding down the SHIFT 

key (for successive selections) or the CTRL key (for multiple selections), then click on OK. 

• To include a single component, click on it using the right mouse button and in the context menu choose 

Add Selected Device To Workspace. 

• Alternatively, you can add devices individually to the workspace by simply double-clicking on them. 

Fohhn Audio Soft searches for Fohhn hardware in all active Fohhn-Net Nodes simultaneously. Fohhn-Net can 

handle a total of 254 IDs altogether: These IDs are allocated globally for the entire Fohhn-Net network. Duplicate 

IDs are not permitted! 

 

4.1.2 Configuration Using Multiple Nodes 

With more complex system setups, more Nodes may be needed. In such cases it might be necessary, under some 

circumstances, to configure the individual Nodes separately within the system. From the Menu Bar select Setup 

> Fohhn-Net Adapter. This will open the Fohhn-Net Configuration dialog, in which all the recognised Nodes in the 

system are listed. The following information will be displayed: 

• Enabled  

If this checkbox is active, the Node is active. Otherwise the Node will not be addressed, i.e. scanned in 

the system, and the connected components will not be found in the network.  

If the Discovering Enabled field is activated, then all Nodes in the system will be automatically searched 

for. 

• Type  

This notes which Node type is connected and how it communicates with the computer.  

Node  

Further information on Nodes, e.g. their IP addresses, or the identification of the USB Fohhn-Net 

Adapter is displayed here. 
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• Description  

This is where the current name of the Node is entered. You can change this as required.  

Please note that this description is not saved in the Node itself, but only in the Fohhn-Net configuration.   

• Timeout 

The current Fohhn-Net timeout / offset is displayed here. 

• Discovered  

The configuration status of the Node is displayed here: An asterisk shows that the Node is automatically 

configured. 

• Status  

This shows the status of the Node in the network: If the Node is active (Enabled) and recognised in 

Fohhn-Net, its listing will be highlighted in green. If the Node has been deactivated (no check under 

Enabled), the orange-highlighted Disabled entry will show up and the Node cannot be searched for in 

the Fohhn-Net network. 

 

To configure a Node, click in the dialog window using the right mouse button. Using the context menu you can 

now make the following settings: 

• Enable/Disable  

This lets you activate or deactivate one or more Nodes (making a multiple selection by using the 

Shift/CTRL key).  

• Set description  

In this dialog you can enter your own description for the Node. 

• Set timeout offset  

Here you can make an adjustment so that Fohhn Audio Soft waits longer for the response from a device. 

This can remedy problems relating to a poor WLAN connection for example. Normally it is best not to 

change the default value (0 ms). Otherwise the system may take longer to respond as a result.  

• Add  

Here you can add further Nodes to the Fohhn-Net. 

• Remove  

This lets you remove a selected Node from the Fohhn-Net. 

If you make modifications to the settings, you can apply these by clicking on the Apply button, without having to 

close the dialog. These settings will then be active. 

Using the Save button, you can save the current configuration as a file on your computer. This will function as a 

backup of the setup.  
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Using Load you can load stored configurations, having saved your entire Fohhn-Net configuration as a file that 

can then be loaded.  

Clicking OK accepts all the changes and closes the dialog. Clicking on Cancel discontinues the configuration. 

 

4.1.3 ID Allocation 

In order for Fohhn Audio Soft to communicate the Fohhn Hardware, each Fohhn-Net component must have its 

own individual ID, via which it can be clearly identified and communicated with. Each Fohhn component is 

allocated a specific default ID. However, you may need to change this default setting in order to avoid conflict 

with other existing components. 

 

To change the ID directly in the Find devices dialog, proceed as follows: 

1. Using the right mouse button, click on a component in the dialog’s list view.  

2. In the context menu select Change Fohhn-Net ID. 

3. In the dialog with the same name, enter a new ID for the component. Make sure that this ID is not 

already in use. 

4. Confirm this entry by clicking OK: The component will now have a newly assigned ID. 

You can also change a component ID while it is in use. The device must already be registered. To do this, proceed 

as follows: 

1. Open the Device List view, either via the View menu, or via the similarly named button on the Toolbar. 

2. Using the right mouse button, click on a component in the Device List display. 

3. In the context menu select Change Fohhn-Net ID. 

4. Using the same dialog, give the component a new ID number, making sure that this ID is not already in 

use. 

5. Confirm this entry by clicking OK: The component will now have a newly assigned ID. 
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4.2 Presets 
Clicking on the Presets button in the Devices view opens a control panel in which you can load and save up to 100 

presets. At the top of the Preset window it shows which preset is currently loaded. The first ten presets are 

factory presets that cannot be overwritten. To restore your device to its default setting, simply load the first 

preset.  

• Load  

To load a preset, just click on the Load button. This opens the preset list. Select one of the presets, then 

click OK. 

 

• Save  

To save a preset, click on Save. This opens 

the preset list. Select a preset number, 

enter a name in the text field then click OK. 

All settings will be permanently saved in 

the device and will remain even when the 

device is switched off.  

 

• Speaker  

Clicking on the Speaker button opens a further window from which you can load speaker presets.   

Right clicking on one of the loudspeaker symbols opens the list of speaker presets. You can also open 

the speaker presets by clicking on either the Select From List or Select From Database buttons. Select 

From List only accesses the speaker presets that are saved to the device, whereas Select From Database 

accesses all available speaker presets.  

 

In the Input-/Output Channels and Speakers views, presets can be simultaneously loaded and saved to multiple 

devices using the context menus. 

1. Load Preset  

This button opens the preset list. Select the desired preset from the list and confirm by clicking OK. 

 



2. Save Preset  

This button opens the preset database. Using a mouse click, select the preferred location in which to 

save your preset.  Under Preset Name, enter the desired name for your preset and confirm this by 

clicking OK. 

 

4.3 System Setup 
Once communication has been established between Fohhn Audio Soft and the various hardware components, 

you can begin configuring your system. 

Before starting to operate your Fohhn loudspeakers, you will need to load the correct speaker presets. With 

some devices, such as controllers, amplifier presets need to be loaded. If you plan to start with a completely new 

configuration, it is best to first load a factory preset (e.g. Preset 1), from which you can then create one of your 

own user presets. 

Having loaded the preset, you can then adjust the settings to suit the current sound situation. You also have the 

possibility to change DSP function parameters – Equalizer, Compressor, Limiter, Noise-Gate, Delay und X-Over – 

as required, and to save these in your own user preset. 

 

4.4 Settings for Devices, Channels and Speakers  
After the system has been basically configured, you can further specify the individual components. With larger 

systems in particular, it makes sense to specifically name the individual devices, loudspeakers and/or channels.  

 

4.4.1 Renaming Devices 

For easier identification within Fohhn Audio Soft, we recommend giving your devices individual names. To do 

this, proceed as follows: 

1. Open the Device List or Devices view, either via the similarly-named entries in the View menu, or by 

using the buttons in the Toolbar.  

2. Using the right mouse button, click on the desired device in the list (Device List) or workspace (Devices). 

3. In the context menu choose Rename Device. 

4. In the Rename dialog, enter a new name for the device and complete the entry by clicking OK. 

This new name will now be adopted in the Device List, Devices and Input-/Output Channels views. 

 

4.4.2 Rename Channels 

With a controller or power amplifier, you have the possibility of separately naming individual channels. To do 

this, proceed as follows:  

1. Open the Devices, Input-/Output Channels or Speakers view, either via the similarly named entries in 

the View menu, or by using the buttons in the Toolbar.  

2. Using the right mouse button, click on the desired device or channel. 

3. Select the appropriate entry in the context menu of the particular view.  

o Devices: Rename Channel > Rename Channel X 

o Channels: Rename 

o Speakers: Rename channel 

4. In the Rename dialog, enter a new name for the channel and complete the entry by clicking OK. 
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This new name will now be adopted in the Devices, Input-/Output Channels and Speakers views. 

 

4.4.3 Arranging the Loudspeakers and Devices  

A further possibility, which makes the Fohhn Audio Soft display easier to handle, is the ability to graphically 

arrange the various loudspeakers and devices on the user interface. For complex applications and/or fixed 

installations in particular, we recommend that the loudspeakers and devices be arranged on the interface in 

exactly the same way that they are physically positioned in the room. 

 

The name shown on the speaker symbol 

corresponds with that of the currently loaded 

speaker preset. If a question mark appears here, the 

loading process may not yet be completed so the 

speaker preset will not be active!  

 

 

To arrange loudspeakers and devices, proceed as follows: 

1. Open the Devices or Speakers views either 

via the similarly named entries in the View 

menu, or by using the buttons in the 

Toolbar. 

2. Arrange the individual loudspeaker 

pictograms and/or devices according to 

the physical positions of the loudspeakers 

and devices in the room.   

 

This arrangement of loudspeakers and devices will be saved in Fohhn Audio Soft and will remain until you change 

the configuration of the arrangement again.  

 

4.4.4 Combine Speakers (Focus Modular and Focus Venue only) 

If you are working with Focus Modular or Focus Venue loudspeakers from the Focus-Series (e.g. FM/I-400), you 

can combine these modules into a single unit. To combine these loudspeakers, proceed as follows: 

1. Open the Speakers view, either via the similarly named entry in the View menu, or by using the button 

in the Toolbar. 

2. Arrange the unit pictograms one above the other, as with the physical units, so that they are touching 

one another on the screen.  

3. Select all these loudspeaker pictograms with the mouse.  

4. Using the right mouse button, click on one of the selected speakers to open the context menu.  

5. Select Combine Speaker Stack. 

 



 

In the loudspeaker pictograms, next to the ID, an C will appear: These means that the loudspeakers are now one 

“Combined Speaker”. 

 

4.5 DSP Functions  
Fohhn Audio Soft gives you direct access to all the parameters and functionality of the Fohhn Audio DSP (digital 

signal processor).  

With the Fohhn Audio DSP, all signal processing functions are calculated in real time. Here you can access all the 

relevant audio parameters and shape the sound of your Fohhn loudspeaker systems according to your 

requirements and taste. 

The following DSP functions are available in the Devices, Input-/Output Channels and Speakers views. In the Input-

/Output Channels and Speakers views, you will find the controls on the right side of the window. In the Devices 

view, you can open the controls by clicking on the relevant buttons for the respective device.  

 

4.5.1 Volume  

Using the fader, the volume level of the relevant channel (-80 to +12 dB) can be controlled and displayed.  

• Fader/Text Field 

Set the desired level either directly by using the fader, or via the corresponding text field. 

• On/Off  

The On/Off button let you switch the relevant channel on or off.  

 

4.5.2 Routing  

Using the Routing button in the Devices view, you can display the channel routing for the relevant hardware and 

set the levels for each of the individual channels. 

• Fader/Text Field  

Set the desired level either directly by using the fader, or via the corresponding text field. 

• On/Off  

The On/Off button let you switch the relevant input signal on or off. 
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• Inv  

Using the INV button, the output signal phase position is inverted/rotated by 180° and its corresponding 

status displayed (red or grey). 

 

• Level indicators  

For correct level control, you have channel-

related level indicators. Clipping is shown 

via a red CLIP indicator.  

 

• Context Menu  

Right clicking in the Routing window opens 

a context menu that allows you to rename 

the relevant device and its individual 

channels.  

 

 

More information on Routing within the Input-/Output Channels and Speakers views can be found in Chapter 

5.2 “Routing“. 

 

4.5.3 Delay 

Here you can set the amount of Delay for each channel. You can also compare any possible delay differences 

between loudspeakers. 

• Delay  

Here you can set the amount of Delay – in either milliseconds or metres – using the rotary control, or 

the corresponding text field.   

• On/Off  

The On/Off button let you switch the Delay on or off. 

 

4.5.4 X-Over 

Here you can set channel-related High- and Low Pass filters. Each channel has a high pass and a low pass filter 

available (Linkwitz-Riley-Characteristic with 24 dB slope). 

• High-pass 

Using either the rotary control or the corresponding text field, you can set the limit of the high pass filter 

(10 Hz to 20 kHz). 

• Low-pass 

Using either the rotary control or the corresponding text field, you can set the limit of the low pass filter 

(10 Hz to 20 kHz). 

• On/Off 

The On/Off button let you switch the high- and low pass filters on or off.   

 

4.5.5 Equalizer 

Here you can set up a 10-band Equalizer for each channel/speaker, including the following parameters: 

• Q 

in this text field you can set the Q factor (e.g. range) of the relevant frequency bands between 0.1 (very 

wide) und 100 (very narrow). 
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• Freq 

In this text field you can set the exact frequency of the relevant frequency bands between 10 Hz and 20 

kHz. 

• Fader 

in this text field you can set how much you want to amplify or attenuate the relevant frequency band 

within a range of +/- 12 dB. 

• On/Off  

Using the On/Off buttons, you can either switch each filter on or off separately, or switch the entire EQ 

on or off. This lets you easily check the influence of any EQ on the sound of your system as a whole.  

 

 

4.5.6 Graph 

This displays the current channel-related EQ curves: Any changes made in the Equalizer are shown here. 

 

 

4.5.7 Dynamics 

Here you can set the following parameters for the dynamics processors (Limiter, Compressor and Noise Gate) 

that are available on each channel:  

• Limit  

Here you can set the threshold, (-50 to +24 dB) at which the Limiter begins to respond, using either the 

rotary control or the corresponding text field. 

Compress  

Here you can set the threshold, (-50 to +24 dB) at which the Compressor begins to respond, using either 

the rotary control or the corresponding text field. 

• Ratio  

Here you can set the compression ratio (1:1 to 1:20), using either the rotary control or the corresponding 

text field. 

• Attack  

Here you can set the attack time of the Limiter/Compressor (0.1 to 200 ms), using either the rotary 

control or the corresponding text field. 
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• Release  

Here you can set the release time of the Limiter/Compressor (0.1 to 1000 ms), using either the rotary 

control or the corresponding text field. 

• Gain  

Here you can set the subsequent Gain for the Limiter/Compressor (-80 to +12 dB), using either the rotary 

control or the corresponding text field.  

• Gate  

Here you can set the threshold at which the Noise Gate activates (-80 to +12 dB), using either the rotary 

control or the corresponding text field.  

• Time  

Here you can set the length of time for which the Noise Gate remains open (1 to 10 s), using either the 

rotary control or the corresponding text field.  

 

 

4.6 Status 
The Status button in the Devices view lets you overlay a window containing information on the Fohhn-Net status, 

the operating time and temperature of the connected devices.  

• Light  

This button lets you switch the blue 

background lighting of the display, or 

rather the blue LED on the front of the 

corresponding device, on or off. 

• Sign  

This button causes the display, or rather 

the blue LED on the corresponding device 

to start flashing.   

• Lock  

This button lets you lock the display of the corresponding device so that changes can no longer be made 

on the device itself and can only be made via Fohhn Audio Soft. This Lock function can also only be 

removed from within Fohhn Audio Soft. 

• Standby  

This button puts the corresponding device into Standby Mode.  

• Protect  

This display lights up green when there are no problems with the corresponding channel. If the 

corresponding channel is found to be in Protect Mode, there is a problem in the hardware. (For example, 

if an overload or a short circuit is detected): In this case the display will light up red. 

• Fohhn-Net  

Here you can see whether the corresponding device is offline or online. 
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• Operating Time  

Here you can see the total operating time of the corresponding device.  

• Temperature  

Here you can see the current temperature of the corresponding device. 

HW status (hardware status) and Fohhn-Net information is also displayed in the Input-/Output Channels and 

Speakers views.  

The Standby, Sign and Light i.e. Light on/Light off functions can also be accessed in the Input-/Output Channels 

view using the context menu.  

 

4.7 Beam Steering and Focus Simulation 

4.7.1 Definition 

In the audio processing world the term “Beam Steering“ refers to the process of controlling the beam dispersion 

characteristics of loudspeaker systems using electronics and software. Through highly controlled overlapping of 

signal sources that are tightly positioned in close proximity to one another, it is possible to “bundle” sound over 

a wide frequency range and adjust the beam angle of the loudspeaker with unparalleled flexibility. In general: 

the longer the loudspeaker, the lower the frequencies that can be included in the “bundle”. Because each 

speaker driver can be individually controlled and adjusted, via use of a dedicated algorithm or DSP, this in turn 

influences the sound dispersion capability of the entire loudspeaker.    

All Fohhn Focus-Series loudspeakers work with Beam Steering Technology, which facilitates this “acoustic 

bundling” and the subsequent control of beam dispersion characteristics. Combining the DSPs with Fohhn Audio 

Soft enables a loudspeaker system’s vertical inclination angle and vertical beam width to be electronically 

controlled – in real time! 

A further advantage of this hardware/software combination is the ability to simulate the acoustic behaviour of 

sound in a room, without the need to have loudspeakers connected. Fohhn Audio Soft lets you configure the 

entire sound system in advance and visually set it up in the room space, even before the actual systems are in 

use at the venue. As required, you can also set up all the relevant acoustic parameters in advance on the screen, 

and then verify the settings in practice. Thanks to Fohhn Audio Soft, adjustments can be made in real time while 

the system is running, without jeopardizing the sound quality. 
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4.7.2 Focus Simulation Parameters 

Adjustable Fohhn loudspeaker parameters include the vertical beam width (in a range of 0 to 90°) and the vertical 

inclination angle (from -40 to +40°). Using Fohhn Audio Soft, these parameter adjustments can be made in real 

time, in highly precise 0.1° increments. 

Fohhn Audio Soft also offers real-time access to other parameters: For example, the acoustic centre of a 

loudspeaker can be set practically anywhere over its entire length. Fohhn’s in-house developed Side-Lobe-Free 

and Two Beam technologies can also be activated using the relevant buttons. 

It is additionally possible to select several Focus-Series devices at once. If these devices have different settings, 

this will be indicated in the parameter field by the use of a warning symbol. Editing a value with a warning symbol 

will result in the new value being adopted by all selected devices. 

 

4.7.3 System Setup (Focus-Series) 

To adjust your system to meet venue requirements, open the Beam Steering view: This display lets you set all 

the parameters that are relevant to Beam Steering. You can either do this offline as a simulation, or online in real 

time. 

The display and operation of the Focus Simulation is covered in the following sections: 

 

The Device Selection  

This shows all the Focus-Series devices that are in the system, along with their IDs, names, type/model 

classifications and current operating status.  

Click on a device entry to select the required loudspeaker (or a “Combined Speaker”) that you want to configure 

in the Parameter Field. The selected device is highlighted in blue. 

 

 

The Parameter Field 

This lets you configure the beam dispersion characteristics of the loudspeaker selected in the Device Selection, 

using the following parameters:  

• X-Pos (m)   

This defines the distance of the selected speaker (in metres) in relation to the vertical back wall. 

• Z-Pos (m)    

Defines the height of the selected speaker’s lower edge (in metres) in relation to the floor.   

• Pre-Angle(°) 

Here you can enter the mechanical inclination of the loudspeaker. This value only influences the display 

in the Focus Simulation. 
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• Freq. (Hz)  

Here you will input the reference frequency for calculation and display in the neighbouring Focus 

Simulation. The frequency you input here will have no effect whatsoever on the sound being reproduced 

by your loudspeaker.  

• Upside Down   

Adding a check mark to this field means that the loudspeaker effectively turns upside down. This can be 

useful if you have to install your Focus-Series loudspeakers head first. 

• Beam 2 (Split)   

Adding a check mark to this field creates a second beam for the loudspeaker in question. The following 

parameters can then be set for both beams, individually and independently from each other. 

• Angle (°)  

Here you can enter the beam’s vertical inclination angle – in 0.1° increments – within a range of  

+/- 40°. 

• Beam (°)   

Adding a check mark to this field lets you set the vertical width of the beam – in 0.1° increments – within 

in a range of +/- 90°. 

• High-pass (Hz)    

Adding a check mark to this field lets you enter the frequency threshold (10 Hz to 10 kHz): The 

fundamental tone below this frequency will be attenuated by 24 dB / Octave (fourth order). The high 

pass is recommended for effective masking of the fundamental tone. 

• Side Lobes > Optimize   

When adding a check mark to this field, Side Lobes will be removed as far as is possible, by means of a 

dedicated Fohhn algorithm: Because this makes the room less “excited”, levels of speech intelligibility 

will be significantly improved. With the overall volume level of the system now somewhat lower as a 

result, you can use the volume control in Fohhn Audio Soft to compensate for this. 

Center (%)   

When Optimize is active, you can change the acoustic centre of the loudspeaker. 0 % means that the 

acoustic centre moves to what is virtually the bottom end of the speaker, whereas 100 % takes it to 

the top end. In its default setting of 50 % (or if Optimize is not active), the acoustic centre sits at what 

is basically the optical centre of the speaker.  

• Trim (dB) 

Here you can attenuate the level of the selected beam over a range of 0 to -90 dB. If two beams are 

active, you can use these fields to set the relative levels of both in parallel.  

 

The Focus Simulation 

This window displays a graphic representation of your selected loudspeaker’s beam dispersion characteristics, 

resulting from the settings entered in the Parameter Field.  
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Focus Simulation with level legend (top right) 

The Focus Simulation shows the position of the beam in the room: The Y-Axis represents the room’s height, while 

the X-Axis represents its depth. You can adjust the sound pressure display by clicking on and moving the level 

range shown in the legend at the top right of the window. 

The window below shows the sound pressure level for the selected frequency at a listening height of 1.70, or 

alternatively, the frequency response at a specific point.  

If the mouse pointer is moving in the Focus Simulation window, you will see the frequency response at the 

position of the actual mouse pointer. If the mouse pointer is outside the Focus Simulation window, you will see 

the sound pressure level at the listening height. 

 

Frequency Response Window 

 

5. Advanced Operation 
Once your system is set up and in operation, we’d like to introduce you to some more advanced operational 

features that are described this chapter. These will enable you to delve deeper into your system using Fohhn 

Audio Soft. 

 

5.1 Creating Groups 
In the Input-/Output Channels view, you can take selected channels across multiple devices and combine them 

to form a group. You can then name this group and highlight it with a colour. This subsequently allows you to 

simultaneously edit and control all the parameters of the channels belonging to the group. For large projects 

involving multiple devices, this is a very helpful tool.  
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To make your selection, click on the channel (holding down the Shift- or Ctrl key for multiple channels) in the 

Input-/Output Channels view. Please note that a channel can only belong to one group at a time! 

To create a new Group, or edit an existing one, open the context menu by right clicking. The following command 

options will be available: 

• Add To Group (Shortcut: C)  

This lets you add one or more selected channels to an existing group.  

• New Group (Shortcut: V) 

This lets you combine several selected channels to form a new group. In the window that opens, you 

can also allocate a colour to this new group, with which it will be highlighted in the Group column. You 

can also name it.  

• Remove from Group  

This function lets you permanently remove all selected channels from their groups.  

• Rename Group / Change Colour (Shortcut: B)  

This lets you change the name and colour of an existing group. In the associated window/dialog, you 

can allocate a (new) colour to the group, with which it will be highlighted in the Group column. In the 

Group Name field, you can enter a specific name for the group.  

• Activate Single Select Mode (Shortcut: F)  

This lets you temporarily disband a selected group: This function can be used with several groups at 

once. The channels belonging to the group will now show up in the Group column with a dotted 

underscore. 

• Activate Group Select Mode (Shortcut: G)  

This lets you choose to re-activate a temporarily disbanded group. The function can be used with several 

temporarily disbanded groups at once. 

 

 

5.2 Routing 
The Routing function lets you establish which input signals will be replayed via which outputs. You can assign 

several input signals to one output channel.  

We recommend that you open this function via the Input-/Output Channels view; although it is also available via 

the Speakers view. Right-click in here, or on the selected channels, and choose Routing in the context menu. 

Alternatively, you can open this window using the hot key shortcut R. 

 



36 
 

Here you can select one or more channels by clicking. The selected channels will be highlighted in blue and can 

now be edited.  

Using the ON/Off buttons in the lower left corner of the window, you can mute or unmute the selected channels.   

Further functions can be accessed from the context menu by right clicking on one of the selected channels:  

• Route > On (Shortcut: Q) 

This lets you remove the muting from a selected channel. 

• Route > Off (Shortcut: W) 

This lets you mute the selected channel. 

• Route > Toggle (Shortcut: E) 

This lets you toggle the status of the selected channel(s).  

• Set Gain (absolute) > Enter Value (Shortcut: T) 

This opens a window in which, using your computer keyboard, you can enter the desired level value for 

the selected channel, or channels. 

• Adjust Gain (Relative)  

In contrast with Set Gain (absolute), here you will not enter absolute values. Instead, you will 

add/subtract the desired level to/from the current values shown in the selected channels.  

• Adjust Gain (Relative) > Enter Value 

Here you can enter level values in dB, in order to raise or lower the level of all selected channels.  

• Polarity 

Normal: This switches the phase position of the selected channel to neutral. 

Invert: This inverts the phase position of the selected channels by 180°. 

Switch: This rotates the phase position of the selected channels by 180° at a time: Non-inverted channels 

will now be inverted, while inverted channels will revert to neutral.  

 

 

5.3 User-defined Controls 
There are numerous applications for which Fohhn Audio Soft’s grouping functions can prove very useful: 

For example, using a Volume Group lets you simultaneously control the volume levels on several loudspeakers. 

Creating a Mute Group Button will let you mute several loudspeakers at once. A Preset Group Button will let 

you call up various presets at the touch of a button. 

 

Volume Groups 

To create a Volume Group, proceed as follows:  

1. Click on the User-defined Controls menu. 

2. Select Add New Volume Group. 

3. Under Devices in the Add New Volume Group window, select the desired devices and/or channels by 

clicking on the corresponding checkboxes. Alternatively, under Channel Groups, you can select a group 

that you have previously created (See Section 5.1 “Creating Groups“). 

4. In the text field at the bottom left of the window, enter a name for your group.  



37 
 

 

5. Confirm your choices and name by clicking OK. 

6. The Volume Group will now be graphically displayed as a new control in the workspace.  

Mute Groups 

To create a Mute Group, proceed as follows:  

1. Click on the User-defined Controls menu. 

2. Select Add User-defined Controls Window: A new window will appear in the workspace. 

3. Right click in the newly opened User-defined Controls window to open the context menu.  

4. Now click on Add New Mute Group Button.  

Under Devices in the Add New Mute Button Group window, select the desired devices and/or channels 

by clicking on the corresponding checkboxes. Here, under Channel Groups, you can also select a group 

that you have previously created (See Section 5.1 “Creating Groups“).  

5. In the text field at the bottom left of the window, enter a name for your Mute Group.  

6. Confirm your choices and name by clicking OK. 

 

7. The Mute Group button will now be graphically displayed as a new control. 
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8. If the control icon is green, the related group is active. If it is grey, the group is muted.   

You can add a new Mute Group Button into the same User-defined Controls window each time. Right click in the 

relevant window and select Add New Mute Group Button. 

If you have created several mute groups, you can also create some Exclusive Options. This means for example, 

that with a single click you can activate one group, while at the same time muting another. To do this, proceed 

as follows: 

1. Right click on the relevant Mute Group icon in the User-defined Controls window to open the context 

menu.  

2. Click on Edit. 

3. In the newly opened Add New Mute Group Button window, select Devices and click on the dropdown 

menu at the bottom of the window.  

4. Choose an Exclusive Option for your Mute Groups e.g. Exclusive 1.  

5. Confirm by clicking OK.  

6. Repeat the process. You can for example choose the same Exclusive Options for several Mute Groups. 

 

 

 

Preset Groups 

To create a Preset Group, proceed as follows:  

1. Click on the User-defined Controls menu. 

2. Select Add User-defined Controls Window. 

3. Right click in the newly opened User-defined Control window to open the context menu. 

4. Click on Add Preset Group Button 
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5.  In the Preset List, select the desired devices and/or channels. Either click on Add to add the selected 

devices to the group, or click on Group Add, to add an existing Volume Group to the Preset Group. In 

the Text field you can enter a name for the Preset Group 

 

6. The Preset Group will now be graphically displayed as a new control. 

7. If the group icon is highlighted in blue, the corresponding group is active. If it is grey, another group is 

active.  

You can add a new Preset Group into the same User-defined Controls window each time. Right click in the 

relevant window and select Add New Preset Group Button 

 

Selecting Function Groups / Controls 

To work with a group, simply click in the corresponding window. With Volume Groups you can adjust levels, or, 

using the On/Off button, switch the group on or off.  

With Mute Groups, clicking on the relevant button will mute/unmute the group in question. 

With Preset Groups, clicking on the relevant button will call up the corresponding preset.  

 

Context Menus for User-defined Controls 

Every Volume Group and User-defined Controls window has its own dedicated context menu. This is opened with 

a right mouse click. Within a User-defined Controls window, each control is also accessed via a further context 

menu.  

Volume Group context menu: 

• Delete window 

Click on this command to delete the entire Volume Group 

• Edit 

Clicking on this command opens the Edit Volume Group window. 

User-defined Controls context menu: 

• Add Mute Group  

Click on this command to add a new Mute Group. In the associated Add New Mute Group Button 

window, you can then select the desired devices and/or channels. This process has already been 

described above.  
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• Add Preset Group 

Click on this command to add a new Preset Group. In the associated Preset window you can then select 

the desired presets. This process has already been described above. 

• Edit 

Click on this command in order to assign a new name to this User-defined Controls window. Enter a new 

name in the Rename window’s text field and confirm by clicking OK. 

• Delete window 

Click on this command to delete the relevant User-defined Controls window and its associated groups. 

Context menu Buttons: 

• Move 

Clicking on this command puts a blue frame around the relevant group. You can then grab this using the 

mouse and move it as required within the User-defined Controls window. 

• Delete button 

Click on this command to delete the relevant Mute- or Preset Group Button. 

• Edit 

Click on this command to edit the groups. In the case of Mute Groups, open the Edit Mute Group 

(Button) window. Proceed as described above in order to make the required edits to your Mute Group. 

For Preset Groups, open the Preset List window. Proceed as described above in order to make the 

required edits to your Preset Group. - 

• Delete window 

Click on this command to delete the relevant User-defined Controls window and its corresponding 

groups. 

 

 

5.4 Sub Arrays 
Fohhn Audio Soft makes it simple for you to combine Fohhn subwoofers into arrays.  This means that their 

dispersion characteristics can also be controlled in real time using the Beam Steering view. 

 

5.4.1 Guidelines 

Please note that you can only combine the same type of Fohhn subwoofers in a Sub Array! In the case of active 

subs, you can however add passive subwoofers as slaves: So for example, it is possible to use an active XS-10 

together with a passive XSP-10. 

However, any amplifiers used with the passive subwoofers must also be structurally identical. It is not possible 

to use different models at the same time. 

If you are using a Fohhn Controller, make sure you are also only using identical amplifiers. 

All subwoofers must be placed an equal distance from one another! It doesn't matter whether the subwoofers 

are arranged vertically or horizontally. 

 

5.4.2 Subwoofers as a Combined Speaker 

The following steps describe how to set up your Bass Array: 

1. Open the Speakers view. 
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2. Arrange the subwoofer symbols in the same order that you have arrange the actual subs. The speaker 

symbols must be touching each other. 

 

3. Select the desired subwoofers. 

4. Right click on one of these subwoofers to open the context menu. Choose the option Combine Speaker 

Stack. 

5. In the dialog that opens, enter the distance between each subwoofer’s centre and confirm by clicking 

OK. 

 

6. Your subwoofers are now combined into a Sub Array. This will appear in the Beam Steering view from 

where it can also be controlled. 

Make sure that you always load the correct speaker presets from the database if you want to configure a Sub 

Array offline (i.e. without physically connected subwoofers)! 

 

Controlling a Sub Array 

1. Open the Beam Steering view. 

2. Your new Sub Array is now shown in the device selection with the name Bass. Under Type it will show 

Bass Stack. 

The Sub Array’s ID is shown as a combined ID in the Beam Steering view(2XXX – whereby X stands for 

the lowest ID of the subwoofers involved). 

3. In the Focus Simulation, the Sub Array is displayed as lines. In a horizontal subwoofer arrangement (i.e. 

next to each other), the Sub Array’s dispersion characteristics are shown as an outline, whereas in a 

vertical arrangement (on top of each other), they are shown as a longitudinal section. 

 

With regard to the parameter field, the beam characteristic configuration is the same as for other Focus-Series 

loudspeakers (see sections 4.7.2 and 4.7.3). 
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5.5 Preset Management 
Fohhn Audio Soft has three different types of presets that are totally independent of one another: 

1. Speaker Presets 

2. Amplifier Presets 

3. User Presets 

As a user, you can only edit the user presets (denoted as Preset for short in the Fohhn Audio Soft menus). As a 

starting point for your own user presets, there are numerous templates available, which you can load into the 

Device List, Devices, Input-/Output Channels and Speakers views. 

Please note that you can only edit user presets and that these are totally independent from speaker and 

amplifier presets! Speaker and amplifier preset settings cannot be saved in user presets – this is in order to 

protect your loudspeakers. 

By default, user presets are saved in the relevant device and not on your computer. It is however advisable to 

also save these presets separately as external files. This means that you will need to export them. 

 

5.5.1 Exporting Presets 

To export a preset, proceed as follows: 

1. Load the relevant preset.  

2. Go to the File menu and choose Export Preset to File: The Select Device dialog will open. 

3. Now select the device from which you want to export the preset, and then click OK. 

 

4. Select a location in which to save the preset and give your user preset a name. Click on Save to confirm 

your choice.  

5. Repeat steps 1 to 4 for all presets that you want to export from any device.  

 

5.5.2 Import Presets  

In order to use one of your own presets, stored on an external medium, in a Fohhn device, you will first need to 

import the preset into the device. Proceed as follows: 

1. Go to the File menu and select Import Preset from File. 

2. Locate the desired preset then click on Open to confirm your choice. 

3. In the Select Devices window, choose the device into which you want to import the preset and confirm 

by clicking OK.  

4. Finally, save the preset to your device. Repeat steps 1 to 4 for any presets that you want to import. 
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5.6 Projects  
A project consists of all the configuration settings for all the devices in a system, including loudspeaker 

positions and Beam Steering settings, as well as all your configuration settings for a particular project. You can 

either load existing projects into Fohhn Audio Soft, or save projects that you have created or edited.  

Please note that using the command Save Project As will only save the presets that are loaded into individual 

devices at the time of saving and will not include any the other existing presets in the relevant device. 

 

5.6.1 Save Project as 

This lets you save the currently loaded project, which you have either created or edited, to a preferred location. 

Saved projects can either be reloaded at a later date, or exchanged with other users.  

To save your configuration as a project, proceed as follows: 

1. Go to the File menu and choose Save Project As. 

2. Select the location in which you want to save your project. Click on Open to confirm your choice. The 

project is now saved. 

 

5.6.2 Load Project 

This lets you load an existing project on your computer. To load a project, proceed as follows:  

1. Go to the File menu item and select Load project. 

2. Now select the desired project. Click on Open to confirm your choice. 

3. In the Loading project dialog window, if the relevant box in the lower right corner is checked, all the 

existing devices belonging to a project will automatically be selected. This selection can be changed as 

required if you don't need all the devices. 
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By default, only the device layout and the group configurations are loaded from the file. All DSP settings 

(EQ, Dynamic, Focus Simulation etc.) are read back from the devices. To load the DSP settings from the 

file and overwrite them in the devices, select the symbol with the yellow arrow: 

 

You also have the option of loading speaker configurations from the file. Please note, however, that the 

appropriate speaker presets must already be stored on the devices. 

4. Click OK to load the project. 

 

5.7 Identifying a Fohhn-Net Device 
1. Open the Devices view. 

2. Click on Status in the graphic display relating to the device in question. 

3. In the opened Status window, click on the Sign button. This button will now be highlighted in blue and 

on the physical device, the blue front LED will begin to flash. Deactivate the button once the device has 

been identified.  

 

5.8 Signal Generator 
Please ensure that the fader you are using to regulate the level of the test signal is pulled right down before 

you activate the test signal itself! In certain circumstances, a test signal could play back at excessive levels that 

might be potentially harmful to you and any other people who are in the same room as the speakers - as well 

as damaging the speakers themselves. 

1. Open the Devices view. 

2. Click on Tools in the graphic display relating to the relevant device. 

3. In the Tools window, click on the Sine or Noise buttons: The relevant button will now be highlighted in 

green and either a Sinus tone or Pink Noise will be generated, depending on your choice. 

Using the fader you can set the level of the test signal and use the rotary control to set the frequency (if 

you selected Sine). 

For multi-channel devices, select a channel that will be used for playing back the test signal. By pressing 

the Ctrl key on your computer keyboard, you can simultaneously select several channels at once. 
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5.9 Changing a Fohhn-Net ID  
In Fohhn-Net, each ID number must only be used once. Should an ID be used more than once, communication 

will no longer be possible with any devices that have this number. In this situation, all such devices must be 

physically separated from one other – either by switching them off, or by removing the network cable – so that 

no ID is duplicated. 

A Fohhn-Net ID can either be changed using the Search Device or Device List view: 

1. Select the device on which you want to change the ID. This will now be highlighted in blue.  

2. Open the context menu (with a right click) and select Change Fohhn-Net ID. 

3. Enter a new ID in the dialog window and confirm your choice by clicking OK. 

 

4. Repeat the process with any other relevant devices. 
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6. Appendix 

6.1 Updating Your Firmware 
The range of functions in your Fohhn system depends not only on Fohhn Audio Soft, but also on the firmware in 

your devices and on the loudspeaker database. From time to time, updates are available for these sets of data, 

which can be downloaded into Fohhn Audio Soft (internet connection required!). An update is performed as 

follows: 

1. Start Fohhn Audio Soft by double-clicking on the desktop icon, or using the path Start > All Programs > 

Fohhn Audio AG > Fohhn Audio Soft. 

2. After the program has started up, click on the Help menu in the Fohhn Audio Soft Menu Bar and choose 

Update Firmware and Speaker Database (internet connection required!). 

Fohhn Audio Soft compares your installed version with the one that is currently available on the server and either 

notifies you that your files are up to date, or offers you a download link for updating.  

 

The above-mentioned process loads the latest Firmware files onto your PC. They will not yet be active on your 

Fohhn devices!  

Proceed as follows to check, or rather update the Firmware on your devices. (This process does not require an 

internet connection since – as described above - the necessary Firmware files are now already loaded onto your 

PC): 

1. From the Devices menu, select Find Devices in Network. The following dialog will open: 
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2. Select the device (via mouse click) whose Firmware you want to update and open the following context 

menu by right clicking:  

 

 
 

3. Now click on Firmware update. The following dialog will open: 

 

4. In the Update column, check the box next to the relevant Fohhn device. If a newer Firmware update is 

available for the device, Fohhn Audio Soft will automatically add an update check. 

5. After you have selected all the relevant Fohhn devices, click on Start. 

6. The latest Firmware will now be installed on the selected Fohhn devices. This process can take several 

minutes. The Status column lets you monitor the progress of this process. Once the Firmware is fully 

installed, it will say ready in this column. 

7. Click on Close to complete the process. 

A Firmware update will restore the respective device to its factory/default settings. This means that any saved 

presets will be lost and cannot be recovered. If you still need any of the presets that have been saved on your 

device, you must first save these with Fohhn Audio Soft, in order to restore them to your device later on.  

 

6.2 Amplifier Setup 
Using Fohhn Amplifier Setups, you can install your own amplifier presets on certain Fohhn devices. You can find 

further information on this is in the user manual belonging to the relevant device.   

1. Using the Search Device / Network Scan dialog, select a device then choose Amplifier Setup in the 

context menu. 

2. All amplifier presets that currently exist on the device will be detected and listed in the Fohhn Amplifier 

Setup dialog.  
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Using this list display in the dialog, you can carry out the following functions: 

• Save amplifier to file  

This command lets you save an amplifier preset from a device as a separate file.  

• Load amplifier from file  

This command lets you load an amplifier preset that has been saved as a file.  

• Edit amplifier  

This command opens the Edit Amplifier dialog, which offers you the following options: 

o Amplifier name  

Here you can name the preset. 

o Power Peak 4ohm [W]  

Here you can enter the peak power in Watts at 4 Ohm. 

o Gain [dB]  

Here you can enter the Gain in dB. 

• Measure new amplifier (FC-9 only)  

This command is used as a system for measuring your own presets, but it can only be used together 

with an FC-9 DSP controller. The process of measuring and creating your own amplifier presets is 

described in the FC-9 user manual.  

Even after the amplifier presets are found to be present in a device, you must still load them into the device 

itself using Fohhn Audio Soft. 

 

6.3 Shortcuts/Hot Keys 
In Fohhn Audio Soft, certain functions can be carried out directly using the keys on your computer keyboard. In 

addition to the global views, which can be directly called up using these shortcuts, it’s also possible to handle 

commands within the Input-/Output Channels view and Routing dialog context menus in this way.  

 

6.3.1 General Shortcuts  

Shortcut Function 

Ctrl + D opens the Device List view 

Ctrl + O imports a preset from a file 

Ctrl + S exports a preset to a file 

Ctrl + Shift + O opens a project 

Ctrl + Shift + S saves a project 

F2 adds a device 

F3 search for a device in the network 

F4 opens the Devices view 
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F5 opens the Input Channels view 

F6 opens the Output Channels view 

F7 opens the Speakers view 

F8 opens the User-defined Controls view 

F9 opens the Beam Steering view 

F11 undocks the active window from the Fohhn Audio Soft user interface 

 

 

6.3.2 Shortcuts for the Input-/Output Channels view context menu  

To perform the following shortcuts, open the context menu in the Input-/Output Channels view. 

Shortcut Menu Command Function 

S Sign causes the blue LED, or the display on the selected device to 

flash so that it can be visually identified 

Y Illumination > Light On switches on the blue Fohhn logo light on the front of the 

speaker 

X Illumination > Light Off switches off the blue Fohhn logo light on the front of the 

speaker  

A Rename opens the Rename dialog, in which you can give the channel a 

user-specific name  

T Set Gain (absolute) > Enter 

Value 

opens the Gain dialog in which you can enter an absolute gain 

value for the channel (to one decimal place) 

Q Set Mute > Output On 

(Play) 

switches the relevant channel on 

W Set Mute > Output Off 

(Mute) 

switches the relevant channel off 

E Set Mute > Output On/Off 

Toggle 

toggles the current status of the relevant channel  

R Routing opens the Routing dialog 

Z Standby opens the Standby dialog, in which you can switch the current 

device on or off 

C Add To Group adds the selected channel to an existing Group 

V Add To Group > New Group opens the New Group dialog, for creating a new Group 

B Rename Group / Change 

Colour 

opens the Rename Group / Change Colour dialog, in which you 

can rename the selected Group, as well as changing its colour 

F Activate Single Select Mode temporarily disbands channels forming a Group 

G Activate Group Select Mode reinstates a temporarily disbanded Group  

 
 

6.3.3 Shortcuts in the Routing dialog 

To perform the following shortcuts, open the Routing dialog via the Input-/Output Channels view context menu:  

Shortcut Menu Command Function 

T Set Gain (absolute) > 

Enter Value 

opens the Gain dialog in which you can enter an absolute gain 

value for the channel (to one decimal place)  

Q Route > On switches the relevant channel on 

W Route > Off switches the relevant channel off  
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E Route > Toggle toggles the current status of the relevant channel  

6.4 Troubleshooting 
If you encounter problems when using Fohhn Audio Soft together with hardware devices, please check out the 

following: 

Fohhn Audio Soft will not start up. 

• Check whether the software has been correctly installed. De-install Fohhn Audio Soft and perform a 
new installation. On the Fohhn website, check whether there is new version of Fohhn Audio Soft 
available for download. 

• Make sure that the operating system currently installed on your computer is compatible with Fohhn 
Audio Soft. 

 

Fohhn Audio Soft does not recognise any devices when searching for them. 

• Make sure that the computer is correctly connected to the Fohhn-Net Adapter. 

• Make sure that the Fohhn device is connected to the Fohhn-Net Adapter. 

• In the ID area of the Search Device / Network Scan dialog, change the value range from 1 to 254, in order 
to find all devices. 

 

There is no sound from the Fohhn system. 

• Check the status of the hardware in the Device List, Devices, Input-/Output Channels and Speakers views. 
Make sure that the Speakers/Channels are not muted and that the networked hardware is Online. 

• Check the volume level settings in the Devices, Input-/Output Channels and Speakers views. 

• Check the settings for the Gate DSP function in the Devices, Input-/Output Channels and Speakers views. 

• Check the settings for the X-Over DSP function in the Devices, Input-/Output Channels and Speakers 
views: It is possible that the upper and lower crossover frequencies are set such that no signal is being 
transmitted.  

• If you have created a speaker group (User-defined Controls > Add Volume Group), check the volume 
fader setting. 

• Check that you have loaded the correct loudspeaker preset for a particular speaker. Loading the wrong 
preset can result in restricted playback or damage to the loudspeaker or amplifier. 
 

 

Communication with a device is interrupted. 

• Check whether the ID allocated to the device in question is also possibly being used by another device. 
If this is the case, switch off one of the devices, or isolate it from the other Fohhn-Net devices and 
allocate a new ID. You can then return it to the Fohhn-Net network. 

 

If your problem has not appeared in the above section, or it has not been rectified after following the 
suggested solution(s), please contact us at the address on the last page of this manual. 
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6.5 Remote Configuration 
Some devices offer you the possibility to switch presets or adjust volume levels using switching contacts or RS-

232 commands. These can be configured as shown below. Please also read the user instructions belonging to 

your Fohhn-Net remote device. 

1. Select your Fohhn-Net device from the Device List in Fohhn Audio Soft and, with a right click, choose 

Presets. The Fohhn-Net Remote Control Setup window will open: 

 

2. Select a signal, and then right click in the empty space on the right to open the context menu. Using Add 

New Command -> Preset, you can add a new command for loading presets. 

3. Choose a Fohhn-Net ID and a Preset then click OK. 

You can configure other signals in a similar way; several commands can be simultaneously implemented for each 

signal. 

Using Write to Device, write the new configuration to your Fohhn-Net remote device. 

This configuration will not be saved as part of your Fohhn Audio Soft project. It must be separately saved using 

Save to File. 

To keep a project simple, we recommend working with preset commands only. However, if you are using Mute, 

Routing or Volume commands, a different means of addressing the Fohhn device channels should be considered. 

For devices that only have DSP functionality on their output channels, the channel can be selected using the 

„Modified output channels“ option. For devices that have DSP functionality on both their input AND output 

channels, the channel must be entered as a value in Channel value mode. The first input channel commences 

after the last output channel. In the case of a device with four input and four output channels, the output 

channels will have values 1,2,3 and 4, for example, while the input channels have 5,6,7 and 8. 
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6.6 Password Lock 
In the Device List view, some Fohhn devices (and their parameter settings) can be password protected (or locked) 

to prevent any inadvertent changes. Three different configuration options are possible: 

1. Unlocked: All parameters can be changed as required. 

2. Completely Locked: No parameters can be changed. 

3. User Presets: Only User Presets can be loaded. 

 

 

If a device is locked, this will be shown by a lock symbol in the Device List: 

• A red lock means completely locked. 

• A yellow lock means that user presets can still be loaded to the device.   

 

Parameters on a locked device can also be edited in Fohhn Audio Soft. However, they can no longer be taken 

over by the device. 

Creating a password protected lock for device settings is done from within the Device List view, using the Settings 

command in the context menu. In the newly opened Advanced device settings dialog, you can then lock/unlock 

the devices using the Password lock menu option. 

 

 

6.6.1 Setting a Password Lock 

The Lock command in the context submenu enables all selected devices to be simultaneously locked. As an 

option, you can still allow saved user presets to be loaded when the device is locked. 
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Having confirmed the dialog entry with OK, the device’s new status – Locked - will then be displayed. From this 

point it will no longer be possible to make any additional changes to the device settings. 

 

6.6.2 Cancelling Password Lock 

The Unlock command in the context submenu enables all selected devices to be simultaneously unlocked. 

 

 

6.6.3 Password Reset (if password is forgotten)  

To reset a password you will need access to both the device management, via Fohhn Audio Soft, and the device’s 

power supply, i.e. its power switch. 

Select Password lock -> Reset, then follow the instructions in Fohhn Audio Soft.  

 

6.7 Disclaimer and Copyright 

6.7.1 Disclaimer 

The contents of this user manual have been created with great care. However, Fohhn Audio AG cannot guarantee 

that the information therein (images, text and other representations) is always complete, correct and current. 

Fohhn Audio AG therefore reserves the right to make changes or additions to the given information at any time. 

Neither Fohhn Audio AG (as a public limited company), nor its Executive Board or employees takes any 

responsibility for direct or indirect damage, including loss of profit, which arises as a result of, or in connection 

with, the information in this manual. 

 

6.7.2 Copyright 

This manual as a whole, including its contents and works is, as such, subject to German copyright law. The 

reproduction, editing, distribution and any other kind of use outside the limits of the copyright requires the 

written consent of Fohhn Audio AG.  
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6.8 Trademarks 
All trademarks, trade names or company names appearing here are, or may be, trademarks or registered 

trademarks of their respective owners. All right are reserved, with the exception of those specifically granted.  

In the absence of an explicitly labelled registered trademark, it cannot be concluded that a name is free of third-

party rights. 

 

6.9 Contact Address 
Fohhn Audio AG 

Großer Forst 15 

72622 Nürtingen 

Deutschland 

Telephone  +49 7022 93323-0 

Fax  +49 7022 93324-0 

Web:  www.fohhn.com 

E-Mail:  info@fohhn.com 
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